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About this On-Line Manual
This On-Line Manual explains the setting procedures required in order to use the Network FAX functions when the Printer/

Scanner Kit* and Fax Kit are installed in your machine. It is recommended that you also read the corresponding Operation

Guide as well.

This manual is prepared as a PDF (Portable Document Format) file, so Adobe Acrobat Reader version 4.05 or later must be

installed on your computer if you want to read the manual without the provided CD-ROM. If you do not already have the

appropriate Adobe Acrobat Reader software, it is recommended that you install it from the CD-ROM.

* In the case of the KM-C850, this is a Scanner Kit.

IMPORTANT!

The use of Adobe Acrobat Reader implies agreement to the terms of use as stipulated by Adobe Systems Incorporated.

Trademark Information

• Microsoft, Windows, Windows NT and Internet Explorer are registered trademarks of Microsoft Corporation of the United

States and other countries.

• Windows Me and Windows XP are trademarks of Microsoft Corporation.

• Ethernet is a registered trademark of Xerox Corporation.

• IBM and IBM PC-AT are trademarks of International Business Machines Corporation.

• Adobe and Acrobat are registered trademarks of Adobe Systems Incorporated.

All other company and product names contained in this On-Line Manual are trademarks or registered trademarks of their

respective companies. The designations ™ and ® will not be used in this manual.

Operating Environment

The Network FAX functions are compatible for use under the following operating environments:

• Hardware ... IBM PC-AT compatible computer

• Interface ... 10BASE-T or 100BASE-TX

• Operating system ... Windows NT 4.0 (Server, Workstation) + SP5 or later,

Windows 2000 (Professional, Server, Advanced Server),

Windows 98 (Second Edition), Windows 95 (OSR2 or later),

Windows Me and Windows XP

The screen shots used in this On-Line Manual are compiled from Windows XP. The actual displays on your computer may

differ depending upon your particular operating system.
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Included Utilities
The following utilities are contained on the provided CD-ROM. In order to use the related Network FAX functions, it is

necessary to follow the appropriate procedure and install the corresponding utility on your computer.

Network FAX Driver
This software allows you to send documents created on your computer to the Printer/Scanner Kit* in this machine, which

converts them to the appropriate format, transfers them to Fax Kit which then transmits them to the other fax machine. The

Network FAX Driver must be installed on the computer from which you want to send the documents.

Address Book for Network FAX
This utility is the address book that needs to be installed on the computer from which you want to send documents. The

Address Book for Network FAX allows you to create and use your own personal fax destination list for sending documents

directly from your computer. It is also possible to import and use CSV-formatted address data that has been created with

other software.

Scanner File Utility
Documents sent from the other fax machine can be received by the Fax Kit in this machine and, once the Printer/Scanner

Kit* is installed, the received documents will be converted to an image file and can be sent to and saved in a folder that is

designated in the Scanner File Utility. Because the Scanner File Utility must be running in order to receive the incoming

data, it is recommended that you install it on a computer that is generally up and running on the network (referred to as the

“Server Computer” in this manual).

* In the case of the KM-C850, this is a Scanner Kit.
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Outline of the Network FAX Functions
The Network FAX functions allow you to send and receive fax documents between computers on your LAN network and the

other fax machines. In addition, if you use the Address Book, you can register individual destinations, or multiple destinations

as an individual group, in advance.

� Transmission function

1. Documents are sent as image data from a network computer over the LAN network to this fax machine.

2. Those documents are sent over the telephone line as a

fax transmission from this fax machine to the other fax

machine.

� Reception function

1. Documents are sent over the telephone line as a fax transmission from the other fax machine to this fax machine where

they are converted into PDF or TIFF file data.

2. That data is sent from this fax machine over the LAN network to the Server Computer.

3. The file is saved on the Server Computer.

Download from Www.Somanuals.com. All Manuals Search And Download.



iv

� Address Book

1. Information for individual destinations (or a group of destinations) is registered in the Address Book software on the

computer from which you want to send documents.

2. The destination for sending documents using the Network FAX function is selected from this Address Book.

3. The documents are then sent as image data from a network computer over the LAN network to this fax machine.

4. Those documents are sent over the telephone line as a fax transmission from this fax machine to the other fax machine

based on the selected destination information. If multiple destinations are registered as a group, the documents will be

broadcast to all of those destinations.

Outline of the Network FAX Functions
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Section 1
Installing the Corresponding Software

1-1  Installing the Network FAX Driver

1. Insert the provided CD-ROM into the CD-ROM drive of the computer in which you want to install the Network FAX Driver.

The set-up screen will appear automatically.

* If the set-up screen does not appear, start the appropriate software manually from the CD-ROM.

2. Read the conditions of use and then click the P button.

3. Click on Network FAX Drivers in the main menu.

4. Click once again on Network FAX Drivers.

5. Follow the instructions in the installation wizard to continue the installation procedure.
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2. Right-click on the name of the machine that you want to use as the Network FAX and select Printing Preferences...  from

the resulting dropdown menu. The Printing Preferences dialogue box will appear.

* To open the Properties dialogue box under Windows 98 and so on, click on Start in the Windows Task Bar and then

select Settings and Printers. Right-click on the name of machine that you want to use as the Network FAX and select

Properties from the dropdown menu. Click on the FAX Setting tab in order to display its contents.

1-1  Installing the Network FAX Driver

� Registering the Machine’s IP address
Once you have installed the Network FAX Driver, perform the following procedure to register the IP address of the

machine that you want to use as the Network FAX.

* The following procedure is explained as though it is being carried out in Windows XP. If you are using another

operating System, use this procedure simply as reference.

1. Click on Start in the Task Bar and then select Control Panel, Printer and other Hardware and then Printers and

Faxes in that order from the successive menus in order to access the Printers and Faxes dialogue box.

(This screen-shot is for when the KM-5035 is installed.)

(This screen-shot is for when the KM-5035 is installed.)
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3. Click on the FAX TX Setting... button in order to access the Default Setting dialogue box.

4. Click on the Machine Setting tab in order to display its contents.

5. In the Network FAX Address area, enter the IP address, or host name, of the machine that you want to use as the

Network FAX.

NOTE: The IP address/host name that you enter here must be the same as that registered in the scanner default settings

of the machine itself. (Refer to "2. Set-up" in the Operation Guide for your Network Scanner.)

1-1  Installing the Network FAX Driver

6. Click on the OK button.

Sample screen-shot of the

scanner default setting window
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1-1  Installing the Network FAX Driver

� Uninstalling the Network FAX Driver
Perform the following procedure when you want to delete the Network FAX Driver from your computer.

1. Click on Start in the Task Bar and then select Control Panel, Printers and Other Hardware and then Printers and

Faxes in that order from the successive menus in order to access the Printers and Faxes dialogue box.

2. Right-click on the name for this printer (normally: Kyocera Mita KM-XXXX NW-FAX), and then select Delete in the

resulting menu.

3. Click on Yes when the confirmation dialogue box appears and the driver will be deleted.
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1-2  Installing the Address Book for Network FAX
1. Insert the provided CD-ROM into the CD-ROM drive of the computer in which you want to install the Address Book for

Network FAX. The set-up screen will appear automatically.

* If the set-up screen does not appear, start the appropriate software manually from the CD-ROM.

2. Accept the conditions of use and then click the P button.

3. Click on Network FAX Drivers in the main menu.

4. Click on Address Book for Network FAX.

5. Follow the instructions in the installation wizard to continue the installation procedure.
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1-3  Installing the Scanner File Utility
1. Insert the provided CD-ROM into the CD-ROM drive of the computer in which you want to install the Scanner File Utility.

The set-up screen will appear automatically.

* If the set-up screen does not appear, start the appropriate software manually from the CD-ROM.

2. Accept the conditions of use and then click the P button.

3. Click on Network FAX Utilities in the main menu.

4. Click on Scanner File Utility.

5. Follow the instructions in the installation wizard to continue the installation procedure.

* If the Select Components screen appears, click on the box next to KM-Network FAX Receive Handler in order to put

a check mark in that box. The content of the other checkboxes is as follows:

• KM-DB Link Handler ... The KM-DB Assist option (Adds file information as keywords to scanned image data files)

• DataBase Link Handler (Sample) ... The Database Assist option (Creates a csv file that includes the registered file

information to go with the scanned image data file)
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Section 2  Sending a Fax

This section contains explanations on how to use the Network FAX Driver to send documents created on a network computer

directly from that computer to the other fax machine.

IMPORTANT!

The Network FAX Driver must be installed on the computer from which you want to send the documents. Refer to “1-1

Installing the Network FAX Driver” on page 1-1 for the procedure to install that software.

2-1  Main Transmission Functions

(1) Delayed Transmission <see page 2-7 for setting procedures>

This function enables you to have documents transmitted at a designated time. Delayed transmission can be carried out at

any time within 24 hours from the time that is actually set in the fax itself.
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Memory 
of the other Fax Machine

(2) F-Code Based Communication <see page 2-15 for setting procedures>

(3) Concurrent print <see page 2-7 for setting procedures>

This function enables you to send documents to an F-Code Box that is registered in a destination fax machine. Because

F-Code Boxes include a sub-address and password, highly confidential communication is ensured. It will be necessary

for you to enter the corresponding sub-address and password of the destination F-Code Box (if they have been

designated for that box) whenever you perform an F-Code Based Transmission procedure.

* For more information on F-Code based

communication, refer to the following:

• KM-3035/4035/5035/C850: "Section 5

Other Features of this Fax"

in the Fax Edition of that

Operation Guide

• KM-2530/3530/4030:

"Section 4  Other Features

of this Fax" in the Fax

Edition of the

corresponding Operation

Guide

This function enables you to print out the documents at the same time as you send them by fax.

(4) Save Transmitted Original <see page 2-7 for setting procedures>

This function enables you to save transmitted documents in the folder that corresponds to the folder number which was

registered under the “Network FAX Registration” settings in the fax machine . Those documents will be saved as a PDF or

TIFF file according to the default “File Type Setting” in the fax

machine itself.

* For more information on registering folder numbers

and on file formats, refer to the following:

• KM-3035/4035/5035/C850: "Section 9

Network FAX Settings (Option)" in the

Fax Edition of that Operation Guide

• KM-2530/3530/4030: "Section 8

Network FAX Settings (Option)" in the

Fax Edition of the corresponding

Operation Guide

2-1  Main Transmission Functions
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(5) Attaching a Cover Page <see page 2-7 for setting procedures>

This function enables you to add a cover page to your transmission that includes such TTI (Transmitting Terminal Information)

data as your company name, department name, your own name, your telephone or fax number, in addition to whatever

comment you’d like to send. The type of cover page you use can be selected from among several different templates.

(6) Restricted Access <see page 2-11 for setting procedures>

When Restricted Access is turned ON

in the copy (or fax) machine itself, this

function enables you to control Network

FAX Transmissions under Restricted

Access as well, only allowing

transmission when a viable access

code that is registered in the copy (or

fax) machine is entered.

* For more information on Restricted

Access, refer to the following:

• KM-3035/4035/5035/C850: "Section

7  COPIER MANAGEMENT" in the

Copier Edition of that Operation Guide

• KM-2530/3530/4030: "Section 4  Other Features of this Fax" in the Fax Edition of the corresponding Operation Guide

2-1  Main Transmission Functions
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2-2  Basic Transmission
1. Use an application on your computer to create the documents that you want to send.

2. Select Print from the File menu.

3. Use the dropdown menu in the Name field to select the name of the machine that you want to use as the Network FAX.

The print dialogue box for the application that you are using will appear.

NOTE: The following screen shot is just an example and the actual dialogue box displayed on your computer may differ

depending to the application that you are using.

4. Enter the number of copies and page numbers that you want to fax.

NOTE: Make sure that the number of copies is set to “1”. If this is set to more than one, more than one set of copies (the

actual number you enter) will be transmitted.

5. Click on the Properties button in order to access the  Properties window.

(This screen-shot is for when the KM-5035 is installed.)

(This screen-shot is for when the KM-5035 is installed.)
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6. Perform all of the desired settings under the FAX Setting tab, such as the original size setting, and then click on the OK

button.

* Refer to “2-3  FAX Setting Tab” on page 2-6 for more detailed information on the settings in that tab.

7. The print dialogue box for the application that you are using will be displayed once again. Click on the OK button. The TX

Setting dialogue box will appear.

* Refer to “2-5  Various Settings in the TX Setting Dialogue Box” on page 2-12 for more detailed information on the

settings in that dialogue box.

8. Use the keyboard to enter the phone number of the destination fax in the FAX Number field. If you want to use the

Address Book to enter this information, refer to “(1) Selecting a Destination from the Address Book” on page 2-12.

• Maximum number of characters that can be entered: 32

• Characters that can be entered: 0 – 9, #, *, -, and a space (a hyphen or space can NOT be entered as the first character)

9. If you are using a cover page, refer to "(3) Registering the Destination Information to be Added to the Cover Page" on

page 2-16.

10. Click on the Add to Destination List button. The entered destination information will be displayed under the Destination

List area.

If you want to send the same documents to more than one destination, repeat steps 8 and 9 as required. (Up to 80

destinations can be registered.)

* If you want to delete a destination from the Destination List area, select that destination and then click on the Delete

from list button. If you want to delete all of the currently registered destinations, click on the Delete All button.

11. Click on the Send button to initiate the fax transmission operation.

2-2  Basic Transmission
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1

2

3

2-3  FAX Setting Tab
Use the contents of this tab to set certain transmission conditions, such as the size of the original being sent.

Refer to “� Registering the Machines IP address” on page 1-2 to open this tab.

1  Original Size field

Use the dropdown menu in this field to select the size of the original being transmitted.

* The size of the documents created in the application will be changed to the size selected here for transmission

purposes.

Available settings: Letter, Legal, Ledger, Statement, A3, A4, A5, Folio, B4 and B5

2  Orientation radio buttons

Make sure the radio button for the desired orientation, either Portrait or Landscape, is selected.

3  Original Image Quality field

Use the dropdown menu in this field to select the resolution quality of the original being transmitted.

Available settings: Normal, Fine, Ultra fine

* When you need to send documents that contain minute text and detailed lines at the best possible quality, select

the Ultra fine setting. The Ultra fine setting will only be available when there is a check mark in the FAX Extended

Memory check box.

* In order to actually send documents at the Ultra fine setting, it is necessary to add additional memory to your fax

machine. (Refer to the Operation Guide for your fax machine.)

4  FAX TX Setting button

Click this button in order to access the Default Setting dialogue box if you want to change the default settings for

fax transmission.

* Refer to “2-4  Default Setting Dialogue Box” on page 2-7 for more detailed information on the settings in that

dialogue box.

4
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2

3

4

2-4  Default Setting Dialogue Box

(1) Sending Options Tab

By setting the transmission conditions that you use most in this dialogue box, you can minimize the need to change the
settings each time.
* The Default Setting dialogue box can be accessed using the following procedure:

Click on Start in the Windows Task Bar and then select Control Panel, Printer and other Hardware and then Printers
and Faxes in that order from the successive menus in order to access the Printers and Faxes dialogue box.
Then, right-click on the name of the machine that you want to use as the network fax and select Printing Preferences
from the resulting dropdown menu. Click on the Fax TX Settings button in the Printing Preferences window. (With systems
such as Windows 98 and Windows Me, click on Start in the Task Bar and then selecting Settings and then Printers in that
order from the successive menus in order to access the Printers dialogue box. Right-click on the name of the machine that

you want to use as the network fax and select Properties from the resulting dropdown menu. Then, click on the Fax TX

Settings button in the Properties window.)

1  Delayed TX checkbox

Put a check mark in this checkbox in order to make the time fields to the right of the checkbox active whenever you want
to set the time that your documents will be transmitted. The desired time setting can be entered directly with the keyboard
or by clicking on the � and � arrows. Enter the time on a 24-hour time basis (00:00 - 23:59).

NOTE: If you designate a time that is earlier in the day than the time that is actually displayed in the fax machine itself, the
transmission operation will be carried out the following day at that time. Be sure to check the time setting in the fax
machine itself before making this setting.

2  Concurrent print checkbox
Put a check mark in this checkbox when you want to print out the documents at the fax machine same time as you send

them by fax.

3  Save TX Original checkbox

Put a check mark in this checkbox when you want to save documents in the computer that was registered under the
“Network FAX Registration” settings in the fax machine.
* For more information on saving the data for transmitted fax documents, refer to the following:

• KM-3035/4035/5035/C850: “Section 9  Network FAX Settings (Option)” in the Fax Edition of that Operation Guide
• KM-2530/3530/4030: “Section 8  Network FAX Settings (Option)” in the Fax Edition of the corresponding Operation

Guide

* For the procedure to save the data for transmitted fax documents, refer to
“3-1 Summary of Delivery Settings” on page 3-2 of this manual.

4  Attach Cover Page checkbox
Put a check mark in this checkbox when you want to add a cover page to your transmission.
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2-4  Default Setting Dialogue Box

Enter the message to be displayed on the cover page and click on the OK button. The message can be up to 1000

characters long.

Perform the following procedure to select the settings for the cover page.

1) Select the desired template for the cover page from the Template of Cover Page dropdown menu.

2) To check the format of the template, click on the Preview button.

The format for the currently selected template will be displayed.

To change the type of template, use the dropdown menu or click on the O or P on the upper portion of the dialogue box.

The display ratio for the template can also be changed to between 25% and 250% using the dropdown menu. If some

destinations have been registered, the format for each destination can be displayed. Click on the O or P next to the

“Recipient” to change the format. (Refer to “(3) Registering the Destination Information to be Added to the Cover Page”

on page 2-16 for more information on registering destinations.) After you are finished previewing the format, click on the

Close button.

3) To add your message to the cover page, click on the Edit Message button.

The Edit Message dialogue box will be displayed.
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1

2

3

4

5

6

(2) Sender Information Tab

Enter your own information into fields 1 – 5 explained below when you want to send a cover page with your faxes.

1  Company Name: Your company name can be up to 64 characters long.

2  Department Name: Your department name can be up to 64 characters long.

3  Name (user name, etc.): Your name can be up to 16 characters long.

4  Telephone Number: Your telephone number can be up to 20 characters long.  [Available characters: 0 - 9, #, *, -, (, ),

&, +, and a blank space]

5  FAX Number: Your fax number can be up to 20 characters long. [Available characters: 0 - 9, #, *, -, (, ), &, +, and a blank

space]

6  E-Mail Address: Your e-mail address can be up to 64 characters long.

[Available characters: Symbols ( !, #, $, %, &, ’, *, +, -, ., /, =, @, [, ], ˆ, _, ‘, {, } )

Alphanumerics (0 – 9, A – Z and a – z)]

* If you register your e-mail address, you will be able to select to have a Network FAX Transmission Report sent to you

as an e-mail attachment.

NOTE: In order to have the Network FAX Transmission Report sent to you by e-mail, it is necessary to turn ON the

corresponding report printout setting (or have it set to “Output on condition”) in the fax default settings and

register the administration's e-mail address in the network fax registration, and carry out the “SMTP” setting in

the scanner default settings.

* It is possible to register the administration's e-mail address in the scanner default settings instead of registering

it in the network fax registration.

2-4  Default Setting Dialogue Box
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2-4  Default Setting Dialogue Box

(3) Machine Setting Tab

When you want to use a different machine as a fax, use this tab to change the IP address, or the host name, to the

information that is registered in scanner default settings of the desired machine. (Refer to “2. Set-up” in the Operation Guide

for your Network Scanner.)

Sample screen-shot of the

scanner default setting window

If you use the host name, your computer must be under a network environment

controlled by a WINS server or a DNS server.

The host name can be up to 32 one-byte characters in length and made up of any of the

following characters: 0 – 9, A – Z, a – z, - (hyphen/dash) and . (period/dot)
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(4) Restricted access Tab

When Restricted Access is turned ON in the copy (or fax) machine itself, transmission will only be allowed when a viable
access code is entered.

If your access code has not been registered under this tab, Non-registration will be displayed in the Department code
field, and Registration completion will be displayed in that field if it has been registered.
* In order to use the Restricted Access function, it is necessary to turn Restricted Access ON in the fax machine itself. For

more information on access codes, refer to the following.
• KM-3035/4035/5035/C850: “Section 7  COPIER MANAGEMENT” in the Copier Edition of that Operation Guide and

“Section 5  Other Features of this Fax” in the Fax Edition of the Operation Guide
• KM-2530/3530/4030: “Section 4  Other Features of this Fax” in the Fax Edition of the corresponding Operation Guide

� Registering your access code
1. If you have not registered your access code under the Restricted access tab, click on the Registration button in order

to access the Department Code Registration dialogue box.

2. Enter your access code (1-8digits) and then click on the OK button. The Restricted access tab will be displayed once
again.

� Deleting your access code

2-4  Default Setting Dialogue Box

1. Click on the Reset button. The registered access code will be deleted from the Restricted access tab and Non-registration

will be displayed once again in the Department code field.
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2-5  Various Settings in the TX Setting Dialogue Box

NOTE
In order to use the Address Book, it is necessary to install it and register the corresponding destinations in advance. Refer
to “4-1 Registering Destination Information” on page 4-2 for more detailed information on destination registration procedures.

1. Click on the Select from Address Book button in order to access the Select Address dialogue box.

(1) Selecting a Destination from the Address Book
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2-5  Various Settings in the TX Setting Dialogue Box

2. The registered destinations will be displayed in the list in the upper portion of the dialogue box.

If you want to search for a particular destination, perform procedures 1) and 2) below. If you do NOT need to search for

a destination, go directly to step 3.

1) Make sure that the desired Search target radio button, either Registration Name or Company Name, is selected.

2) Enter the text to be searched for in the Search Item field. The text can be up to 64 characters long.

The search operation will begin as soon as the first character is entered. Only those entries that start with exactly the

same character(s) as the search criteria will be displayed in the list. If there are no entries that match the search criteria

in this way, nothing will be displayed in the list.

* To display all of the entries registered in the Address Book once again, click on the Display all button.

3. To add a destination from the list of destinations in the Address Book (upper list) to the Destination List (lower list), click

on the desired destination to select it and then click on the Add to Destination List button.

* When you select an entry which multiple destinations have been registered as a group, the Detail button appears on

the top of the dialogue box.

* If you select an entry registered as a group and click on the Detail button, a Confirm members in selected group

dialogue box will appear so that you can verify all of the destinations in that group.

Once you are finished verifying the information, click on the OK button to return to the Select Address dialogue box.
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4. Only those destinations selected from the Address Book will be displayed the Destination List.

* If you want to delete any of the destinations from the Destination List, select that destination and then click on the

Delete from list button. If you want to delete all of the destinations from the Destination List, click on the Delete All

button.

5. Click on the OK button. The Select Address dialogue box will close and the destinations that were registered in the

Destination List will be displayed in the TX Setting dialogue box.

2-5  Various Settings in the TX Setting Dialogue Box
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(2) F-Code Based Communication

2. Enter the sub-address and password as it is registered in the destination fax.

• Maximum number of characters that can be entered: 20

• Characters that can be entered: 0 – 9, #, *, and a space (a space can NOT be entered as the first character)

3. Click on the OK button. The TX Setting dialogue box will be displayed once again.

2-5  Various Settings in the TX Setting Dialogue Box

1. Click on the Option button in the Address Setting tab of the TX Setting dialogue box.

The Option dialogue box will be displayed.
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2-5  Various Settings in the TX Setting Dialogue Box

(3) Registering the Destination Information to be Added to the Cover Page
The type of cover page can be selected from among different templates. Destination information such as that shown below can be added

on the cover page.

Sample of English template 01

1

2
3

4

5

6

7

8

10

9

1 Recipient Name

2 Destination Company Name

3 Destination Department Name

4 Destination Fax Number

5 Sender Name

6 Sender Company Name

7 Sender Department Name

8 Sender Fax Number

9 Sender Telephone Number

10 Message

1. Enter the destination fax number in the Address Setting tab. (Refer to step 8 on page 2-5.)
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2-5  Various Settings in the TX Setting Dialogue Box

1  Company Name: The name of the destination company can be up

to 64 characters long.

2  Department Name: The name of the destination department can

be up to 64 characters long.

3  Recipient Name: The name of the person to whom you are sending

the fax can be up to 20 characters long.

1

2

3

2. Click on the Option button and enter the recipient information.

3. Click on the OK button. The display will return to the TX Setting dialogue box.

4. Click on the Add to Destination List to add the entered information to the destination list.

5. If the sender information is not registered in the Default Setting dialogue box, click on the Sender Information button to

register the sender information. Refer to “(2) Sender Information Tab” on page 2-9.

6. Click on the Cover Page tab.

The setting that was registered for the “Cover Page" under "2-4 Default Setting Dialogue Box” on page 2-7 will be

displayed.

To change the setting, perform the following procedure:

1  Attach Cover Page checkbox: Verify that there is a check mark here.

2  Template of Cover Page selection box: To change the template, select a new template here.

3  Edit Message button: Click on this button to change the message on the cover page. The message can be up to

1000 characters long.

4  Preview button: Click on this button to display the contents of the newly selected template on the Preview of Cover

Page. Refer to step 2) on page 2-8 on how to see the dialogue.

1

2

3

4
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(4) Optional Settings

1. If you want to temporarily change the settings (the present settings will be displayed) from those which are currently

designated in the “(1) Sending Options Tab” or the “(4) Restricted access Tab” under “2-4  Default Setting Dialogue

Box” on pages 2-7 and 2-11, click on the Option tab in order to access the Option tab.

NOTE: The changes made here will only apply to the present transmission and the corresponding settings will return to

those previously made in the Default Setting dialogue box once that transmission is completed.

2. Refer to “(1) Sending Options Tab” on page 2-7 and “(4) Restricted access Tab” on page 2-11 for more detailed

information on the corresponding settings in those tabs.

3. To start the fax transmission, click on the Send button.

To continue the settings for other tabs, click on another tab.

2-5  Various Settings in the TX Setting Dialogue Box
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(5) Transmitting Terminal Information Data

1. If you want to temporarily change the settings (the present settings will be displayed) from those which are currently

designated in the “(2) Sender Information Tab” under “2-4  Default Setting Dialogue Box” on page 2-9, click on the

Sender Information tab in order to access the Sender Information tab.

NOTE: The changes made here will only apply to the present transmission and the corresponding settings will return to

those previously made in the Default Setting dialogue box once that transmission is completed.

2. Refer to “(2) Sender Information Tab” on page 2-9 for more detailed information on the corresponding settings in that

tab.

3. To start the fax transmission, click on the Send button.

To continue the settings for other tabs, click on another tab.

2-5  Various Settings in the TX Setting Dialogue Box
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2-5  Various Settings in the TX Setting Dialogue Box

(6) Machine Settings

1. If you want to temporarily change the Network FAX address (IP address or host name registered in the scanner default

settings of the machine itself) from that which is currently made in the “(3) Machine Setting Tab” under “2-4  Default

Setting Dialogue Box” on page 2-10, click on the Machine Setting tab in order to access the Machine Setting tab.

NOTE: The changes made here will only apply to the present transmission and the corresponding settings will return to

those previously made in the Default Setting dialogue box once that transmission is completed.

2. Use the keyboard to enter the Network FAX IP address (IP address registered in the scanner default settings) or the

Network FAX host name (host name registered in the scanner default settings).

3. To start the fax transmission, click on the Send button.

To continue the settings for other tabs, click on another tab.
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2-6  Transmission Control
Perform the following procedure when you want to use your computer to verify the status of a fax transmission currently

being processed, or to actually terminate that transmission.

1. Once a fax transmission begins being processed, a Transmission Control icon will be displayed in the Windows Task Bar.

2. Double-click on that icon in order to access the Sending Control window which indicates the status of all transmissions

being processed.

3. If you want to terminate any transmission, select that transmission and then select Cancel from the Document menu.

INFORMATION

If you right-click on the Transmission Control icon, the menu shown below will appear.

Select Exit to quit Transmission Control and delete the icon from the Task Bar.

Select Default setting in order to access the Default Setting dialogue box for Network FAX Transmission. Refer to “2-4

Default Setting Dialogue Box” on page 2-7 for more detailed information on the settings in that dialogue box.

Select Version Information if you want to check the version of your Transmission Control software.
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Section 3  Receiving a Fax

If Network FAX Reception is turned ON as the default setting in the fax machine itself, incoming faxes will be converted into

PDF or TIFF files and saved into the designated folder on the Server Computer (the computer on which the Scanner File

Utility has been installed). In addition, you can select to have the result of the reception sent by e-mail to a designated

computer. Notice of the reception of a fax can be sent to other computers by standard e-mail as an attached image. In

addition, it is possible to send a notice of fax reception to any other computer on the network that has the Scanner File Utility

installed.

NOTE

In order to enable fax reception, be sure to perform the required settings in both your computer and the fax machine itself.

Settings in Your Computer

• Install the Scanner File Utility in the computer in which you want to receive the fax data. Refer to “1-3  Installing the

Scanner File Utility” on page 1-6 for more detailed information on installing that utility.

Settings in the Fax Machine Itself

• Turn Network FAX Reception ON and select whether or not to have received faxes printed out at the fax machine itself.

• Under “IP address / Host Name” in the “Network FAX Registration” settings, register the IP address or host name of the

computer in which you want to receive the fax data (Server Computer).

* For more information on settings in the fax machine itself, refer to the following.

• KM-3035/4035/5035/C850: “Section 9  Network FAX Settings (Option)” in the Fax Edition of that Operation Guide

• KM-2530/3530/4030: “Section 8 Network FAX Settings (Option)” in the Fax Edition of the corresponding Operation Guide

NOTE

In order to enable fax reception, be sure that the Scanner File Utility is running. When the Scanner File Utility is running, an

icon that indicates that the utility is running will appear in the Windows Task Bar.
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3-1  Summary of Delivery Settings

The following describes the procedure for setting the folder in which documents received by the Network FAX will be stored.

Refer to the procedures starting from "3-2 Starting the Scanner File Utility" for more detailed information on each setting .

The folder that is used for the storage of transmitted documents can also be set using this procedure.

1  Starting up the Scanner File Utility
Use the Start button to start up the Scanner File Utility and double-click

on the icon in the Windows Task Bar in order to access the Scanner File

Utility dialogue box.

-> Refer to page 3-4

2  Setup Dialogue Box
This dialogue box is used to select the management settings for the

destination folder, such as the settings for the capacity of the hard disk, for

the display of the fax reception notification window, etc.

-> Refer to page 3-5

3  Folder Setting Dialogue Box
This dialogue box is used to set the number or the address of the folder in

which received documents will be stored.

-> Refer to page 3-6
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3-1  Summary of Delivery Settings

4  Delivery Setting List Dialogue Box
Delivery conditions can be selected from among the

Subaddress, Sender Fax Number, Destination Fax Number

and Other settings. In addition, you can select whether sending

a notice of fax reception by e-mail or by using the Scanner

File Utility and perform the related settings for that in the

Configuration dialogue box.

-> Refer to page 3-7

5  Delivery Setting Dialogue Box
This dialogue box is used to select the folder where documents

will be stored, the e-mail address to which the notice of fax

reception will be sent, etc.

-> Refer to page 3-10
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3-2  Starting the Scanner File Utility

1. Click on Start button in the Windows Task Bar and then select All Programs > Scanner User Software > Scanner File

Utility in that order. The Scanner File Utility will start up and an icon that indicates that the utility is now running will

appear in the Windows Task Bar.

2. Double-click on that icon in order to access the Scanner File Utility dialogue box.

3. To continue making delivery settings, click on the Setup button and proceed to the following procedure, “3-3 Setup

Dialogue Box”.
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1

3

2

4

1. Perform the various settings as appropriate.

4  Permit File Overwrite checkbox

Put a check mark in this checkbox if you want to have the corresponding old data overwritten anytime a new fax data

file is received with the same file name. If this box is not selected, a different name will be assigned to the new data file

and that file will be saved with the new name.

3-3  Setup Dialogue Box

1  Hard Disk Warning (%) field

If the volume of data on the hard disk reaches the percentage registered here during saving of received fax data to

disk, a warning message will be displayed.

The desired setting can be entered directly with the keyboard or by clicking on the � and � arrows.

2  Maximum of Received File List field

This setting determines the maximum number of files that will be displayed under the Received File List in the

Scanner File Utility dialogue box. (Available setting: between 10 and 100)

Once the limit designated here is reached, the oldest data will be replaced (overwritten) by any newly received fax

data.

The desired setting can be entered directly with the keyboard or by clicking on the � and � arrows.

3  Reception Notice checkbox

Put a check mark in this checkbox if you want to have a reception notification window appear on your computer monitor

screen anytime new fax data is received. Click on the Open button in the displayed window in order to access the

Scanner File Utility dialogue box, or on the OK button to close the window.

2. To continue making delivery settings, click on the New button and proceed to the following procedure, “3-4 Folder

Setting Dialogue Box”.
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1

2

3

4

5

1. Perform the various settings as appropriate.

3-4  Folder Setting Dialogue Box

1  No. field
Enter in this field the designated number of the folder in which you want to receive the fax data.
* The folder number you enter here should be the same as the folder number which was registered under the “Network

FAX Registration” settings in the fax machine.
* If you need to verify a registered folder number, refer to the following.

• KM-3035/4035/5035/C850: “Section 9  Network FAX Settings (Option)” in the Fax Edition of that Operation Guide

• KM-2530/3530/4030: “Section 8  Network FAX Settings (Option)” in the Fax Edition of the corresponding Operation
Guide

2  Folder field
Enter in this field the location of the destination folder. You can also browse for the folder location by clicking on the ...
button to the right of the field.

3  Password Setting button
This button is only available for use with the scanner function. It is not used under the Network FAX functions and

nothing will happen even if you click on it and enter a password.

4  Comment field

Enter in this field any comments that you’d like to have appear in the Setup dialogue box.

5  System Connection Program field

Click on the � arrow to the right of this field and select Network FAX Receive Handler from the resulting dropdown
menu. The Further Settings button will be made active.

2. To continue making delivery settings, click on the Further Settings button and proceed to the following procedure, “3-5 Delivery

Setting List Dialogue Box”.

Download from Www.Somanuals.com. All Manuals Search And Download.



Page 3-7

1. Select the desired method of data delivery from the Delivery Method list. Available settings: Subaddress, Sender Fax
number, Destination Fax number, and Other.
* For the procedure to determine delivery conditions, refer to “3-7 Determining the Destination Folder” on page 3-13 of

this manual.

Note

For more details on the Error Log button, refer to “3-9 Checking a Reception Notification Error” on page 3-14.

2. Click on the Configuration button. The Configuration dialogue box will be displayed.

3-5  Delivery Setting List Dialogue Box
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3-5  Delivery Setting List Dialogue Box

1

2

3

4

5

3. Select the transmission method for the notice of fax reception.

To have the notice of fax reception sent by e-mail, put a check mark in the Send reception notification E-mail checkbox.

To have the notice of fax reception sent to any other computer on the network that has the Scanner File Utility installed,

put a check mark in the Send reception notification to Scanner File Utility of other PC check box. The settings

related to the respective check marks will then be available.

1  SMTP Server Name edit box

Enter the IP address or host name of the SMTP server address to be used when sending the notice of fax reception.

(Refer to “2-6 System Setting” in the On-Line Manual for your scanner.)

The server name can be up to up to 32 characters long.

* This setting is shared for all folders, so any changes made here will affect the settings for all other folders as well.

2  SMTP Port number edit box

Enter the port number of the SMTP server to be used when sending the notice of fax reception. (Available setting:

between 1 and 32767, default setting: 25). (Refer to “2-6 System Setting” in the On-Line Manual for your scanner.)

* This setting is shared for all folders, so any changes made here will affect the settings for all other folders as well.

3  Attach file to reception notification E-mail check box

Put a check mark in this checkbox when you want to attach the image file of the received fax to the reception

notification mail.

4  Data size edit box

Select the maximum size for files attached to the reception notification mail.

You can choose from among “Low”, “Mid.”, “High” and “Non-restricted”. Files which exceed the size limit will not be

attached.

* The approximate size limits for each setting is as follows, but this should not be taken as an exact representation of

actual performance ability.

“Low”: 0.5 MB, “Mid.”: 1.0 MB, “High”: 2.0 MB

5  Retention period of reception notification edit box

Set the number of days, between 0 and 31, that retransmission of the notice will be attempted in case the computer

set to receive the notice of fax reception is not turned on.

4.  Click on the OK button. The display will return to the Delivery Setting List dialogue box.

5. To continue making delivery settings, click on the New button and proceed to the following procedure, “3-6 Delivery

Setting Dialogue Box”.
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3-5  Delivery Setting List Dialogue Box

Sample of the notice of fax reception
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1

2

3

3-6  Delivery Setting Dialogue Box

Note: The following screen will be displayed after you select the subaddress.

1. Set the various delivery conditions that were selected in the Delivery Setting List dialogue box.

1  Subaddress, Sender FAX number, Destination FAX number and Other edit boxes

• Enter the subaddress: Enter between 4 and 20 digits. Be sure to enter the same 4 digits as the subaddress of the F-

code box as registered in the fax unit.

• Enter the sender fax number and the destination fax number: The fax numbers can be up to 20 digits long. Spaces, and

characters such as + (only for the Sender fax number) or *, can also be entered.

Note: Entry using the (*) wild card symbol

If, for example, you enter *123-4567, all destination fax numbers ending with 123-4567 will be stored in the same folder.

Conversely, if you enter 06-123*, all destination fax numbers starting with 06-123 will be stored in the same folder.

If you enter *123*, all destination fax numbers that include 123 will be stored in the same folder.

• For the Other setting: Fax transmission Document or Reception Fax will be displayed in the edit box.

* For more details about the subaddress, use the following references.

• KM-3035/4035/5035/C850: “Section 5  Fax Operation (functions)” in the Operation Guide for the corresponding

  fax unit.

• KM-2530/3530/4030: “Section 4  Fax Operation (functions)” in the Operation Guide for the corresponding fax unit.

2  Destination Folder box

Displays the name of the folder where received files are to be stored. Select a name in the folder list that is displayed

under the box. A maximum of 256 characters will be displayed.

* New folders other than those displayed under the box can be set as well.

3  Destination Folder List

Displays a list of the sub-folders within that folder that is set as storage folder.

Folders contained within the sub-folders can also be displayed. The following settings can also be made by clicking on a

sub-folder with the right mouse button.

• “New”: To create a new folder within the folder on which you clicked.

• “Rename”: To change the name of the folder on which you clicked.

• “Properties”: A dialogue box of the shared settings for the folder on which you clicked will be displayed.
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4

5

6

7

3-6  Delivery Setting Dialogue Box

4  Reception Notification E-mail Address (Reception Notification PC Address) list
The notice of fax reception can be sent to computers on the network through e-mail or using the Scanner File Utility. Up

to 10 e-mail addresses or computer addresses can be entered. Perform the following procedure to enter the desired e-
mail addresses or computer addresses. (To select the transmission method for the notice of fax reception, refer to the
setting explained under “3-5 Delivery Setting List Dialogue Box” on page 3-7.)

Note: To send the notice of fax reception to a computer on the network using the Scanner File Utility, the Scanner File
Utility must be installed on the destination computer. In addition, the delivery folder must also be set so that it is shared
on the network.

1) Click on the New button. The edit box will be displayed over the list.

2) Enter the mail address (max. 64 characters). In the case of a computer address, you can only enter a maximum of 32

characters.

Example of mail address registration Example of computer address registration

5  ... button

Click on this button to add an e-mail address or a computer address. When registering e-mail addresses, the E-Mail

Address dialogue box will be displayed. (Refer to “� Adding an e-mail address” on page 3-12.) When sending the notice

of fax reception to a computer on the network, the Browse for Computer dialogue box will be displayed. (Refer to

“� Adding a computer address” on page 3-12.)

6  Edit button

Click on this button to edit the e-mail address or computer address that you selected in the list.

7  Delete button

Click on this button to delete the e-mail address or computer address that you selected in the list.
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3-6  Delivery Setting Dialogue Box

� Adding an e-mail address

To add an e-mail address that was previously registered in other delivery settings, click on the ... button. The E-Mail

Address dialogue box will be displayed. Select an e-mail address from list and click on the Add button. When you are

through adding  addresses, click on the OK button. The display will return to the Delivery Setting dialogue box.

� Adding a computer address

To see the computers on the network under the Entire Network directory and then register the address of the computer(s)

to which the notice of fax reception will be sent, click on the ... button. The Browse for Computer dialogue box will be

displayed. Select a computer in the tree and click on the OK button. The display will return to the Delivery Setting

dialogue box.

2. Click on the OK button. When creating a new folder, the confirmation box for the creation of a new folder will be displayed.

Click on the OK button one more time. The display will return to the Delivery Setting List dialogue box.

The settings for the storage folders are now completed.
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3-7  Determining the Destination Folder

The destination folder for delivery of the received fax data will be determined based on the settings made under “3-5
Delivery Setting List Dialogue Box” on page 3-7.

The priority of delivery conditions is as follows:
1. Subaddress
2. Sender’s fax number
3. Other

1. Any subaddress sent from the transmitting fax machine will be checked to see if it matches any of the subadresses
registered in the delivery method settings of each destination folder. If it does, the received fax data will be sent to that
folder.

2. If a subaddress was not sent, or the subaddress does not match any folder settings, the fax phone number of the
transmitting fax will be checked to see if it matches the Sender Fax Number information registered under any of the
destination folders.

3. Lastly, delivery priority will check the Other settings in order to delivered the data to a destination folder.
* Only 4-digit subadresses sent from transmitting fax machines will be checked. If a subaddress of 5 digits or longer is

received, even if the last 4 digits match, the documents will not be delivered into the designated folder.

3-8  When a notice of fax reception is sent
When a notice of fax reception is sent from the server computer, the following screen will be displayed on the computer
receiving the notice.
Note: The Scanner File Utility must be running on the computer that will receive the notice of fax reception. In addition, be

sure that there is a check mark in the Reception Notice checkbox in the Setup dialogue box. (Refer to the settings
explained under “3-3 Setup Dialogue Box” on page 3-5.

� To see the documents that were received by fax
1. Click on the Open button in the reception notice window shown above. Then, double-click on the Scanner File Utility icon

on the Windows Task Bar. The Scanner File Utility dialogue box will be displayed.

* When a notice of fax reception is received, the icon          will appear in the Receive File List.

2. Refer to “3-10 Opening Received Faxes” on page 3-15 and open the received documents.
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3-9  Checking a Reception Notification Error

1 2 3 4

When a notice of fax reception is sent from the server computer to a computer on which the Scanner File Utility is installed

but the notice could be delivered because the receiving computer is not turned on, or there is some other error, the status of

the error can be checked on a list.

* Reception notices that were successfully retransmitted will be deleted from the list. For more details on the setting for the number

of days that retransmission will be attempted, refer to step 3 of “3-5 Delivery Setting List Dialogue Box” on page 3-8.

1. Click on the Error Log button in the Delivery Setting List dialogue box. The Error Log dialogue box will be displayed.

The following items are displayed in the list.

1  Date & Time

The date and time the documents were received by the fax unit.

2  Receiving notice point PC Address

The address of the computer to which the notice of fax reception was sent.

3  Status

Shows the cause of the error. The types of error are as follows.

“connection error”: The computer to which the notice of fax reception was sent is not running or the address of the

computer to which the notice of fax reception was sent is wrong.

“version error”: The installed Scanner File Utility is older than “Version 3.7”.

4  File Name

File name of the received documents.

Download from Www.Somanuals.com. All Manuals Search And Download.



Page 3-15

3-10  Opening Received Faxes

2. Select in the Received File List the file that you want to open.

* Files listed in red (or indicated with an asterisk “*” next to the date) indicate those files which have not been opened yet.

Once a file is opened, the file is listed in black.

3. Click on the Open File button to open the selected file.

* You can also open any file by double-clicking on its name. However, if the file is a PDF file, Acrobat Reader will be

required in order to read it (Acrobat Reader is available on the provided CD-ROM).

REFERENCE

If you want to search for the folder where a specific received fax file is saved, select a file name from the list and click on the

Open Folder button. The location of that folder will be displayed.

Received fax data will be displayed in the Received File List within the Scanner File Utility dialogue box.

1. If the Scanner File Utility dialogue box is not open, double-click on the Scanner File Utility icon in the Windows Task

Bar.
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3-11  Deleting Received Faxes
Is it recommended that you delete received fax data periodically and as necessary.

1. If the Scanner File Utility dialogue box is not open, double-click on the Scanner File Utility icon in the Windows Task

Bar.

2. Select the file that you want to delete.

3. Click on the Delete button to delete the selected file from the Received File List.

* In order to actually delete the file data from your computer, you will need to delete it directly from the folder in which it

is saved.
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Section 4  The Address Book

The Address Book allows you to register information about individual destinations, or groups of destinations for Broadcast

Transmission, in advance. It is also possible to import and use CSV-formatted address data created with other software.

NOTE

It is necessary to have Address Book for Network FAX installed in each computer which will be used for fax transmission in

order to use the Address Book. Refer to “1-2  Installing the Address Book for Network FAX” on page 1-5 for more detailed

information on installing that software.
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4-1  Registering Destination Information
You will need to register destination information in advance if you want to select a destination from the Address Book when

sending a fax.

1. Click on Start button in the Windows Task Bar and then select All Programs > FAX User Software > Address Book for

Network FAX in that order from the successive menus in order to access the Address Book for Network FAX dialogue

box.

2. Select New under the Edit menu and then select New Address from the successive submenu (or click on the  New

Address button). The Registering a New Address dialogue box will appear.
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1

2

3

4

5

6

7

1  Registration Name field: The destination name can be up to 16 characters long.

* You can not register a name that has already been registered.

2  Fax Number field: The destination fax number can be up to 32 characters long. [Available characters: 0 – 9, #, *, -

and a space (a space can NOT be entered as the first character)]

3  Subaddress field: The sub-address can be up to 20 characters long. [Available characters: 0 – 9, #, * and a space

(a space can NOT be entered as the first character)]

4  Password field: The password can be up to 20 characters long. [Available characters: 0 – 9, #, * and a space (a space

can NOT be entered as the first character)]

5  Company Name field: The company name can be up to 64 characters long.

6  Department Name field: The department name can be up to 64 characters long.

7  Recipient Name field: The name of the recipient can be up to 20 characters long.

4. Click on the OK button.

The entered information will be displayed in the address list area of the Address Book for Network FAX dialogue box.

5. In order to actually register the new information in the Address Book, select Apply from the File menu (or click on the 

Apply button).

4-1  Registering Destination Information

3. Perform the various settings as appropriate.
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4-2  Registering Multiple Destinations as a Group

2. Click on the Add button in order to access the Add New Address dialogue box.

3. Select from the Names that can be added list the destination that you want to add to the group. it is possible to select

multiple destinations at one time.

4. Click on the Add>> button.

The selected destinations will be moved to the Address to be added list. (Up to 80 destinations can be registered to

each group.)

* If you want to delete a destination from the Address to be added list, select that destination in that list and then click on

the <<Delete button.

5. Click on the OK button to return to the Registering a New group dialogue box.

The names you selected Add New Address dialogue box will be added to the group.

* If you want to delete a destination from the group, select that destination and then click on the Delete button.

Perform the following procedure if you want to register information for multiple destinations as a single group.

1. Select New under the Edit menu of the Address Book for Network FAX dialogue box and then select New Group from

the successive submenu (or click on the  New Group button). The Registering a New group dialogue box will

appear.
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6. Enter in the Registration Name field a name for the group of destinations. The group name can be up to 16 characters

long.

7. Click on the OK button.

The entered group information will be displayed in the address list area of the Address Book for Network FAX dialogue

box.

8. Click on the OK button.

9. In order to actually register the new group information in the Address Book, select Apply from the File menu (or click on

the  Apply button).

4-2  Registering Multiple Destinations as a Group
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4-3  Address/Group Copy

It is possible to copy a registered address or group and partly edit the contents for registration as a new address or group.

This is convenient for cases when the contents you want to register are close or similar to already registered information.

1. With the Address Book for Network FAX dialogue box open, select the address or group that you want to copy.

2. Under the Edit menu, click on Copy and then on Paste. The Registering a New Address dialogue box or the Registering

a New Group dialogue box, as appropriate, will be displayed.

3. Edit the registered information.

To edit an address, refer to "4-1 Registering Destination Information" on page 4-2.

To edit a group, refer to "4-2 Registering Multiple Destinations as a Group" on page 4-4.

4. Click on the OK button.

5. In order to actually register the edited information in the Address Book, select Apply from the File menu (or click on the

 Apply button).
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4-4  Editing Individual and Group Destination Information

2. Click on the  Edit button (or double-click on the entry you want to edit).

3. Edit the registered information.

To edit information for an individual destination, refer to “4-1  Registering Destination Information” on page 4-2.

To edit information for a group of destinations, refer to “4-2  Registering Multiple Destinations as a Group” on page 4-4.

4. Click on the OK button.

5. In order to actually register the edited information in the Address Book, select Apply from the File menu (or click on the

 Apply button).

1. With the Address Book for Network FAX dialogue box open, select the individual or group destination entry that

contains the information that you want to edit.

An icon will appear above the list to indicate whether it is an individual ( ) or group destination (  ).

(1) Editing Information for an Individual or Group Destination
Perform the following procedure to edit information for an individual or group destination.
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4-4  Editing Individual and Group Destination Information

(2) Editing Information for More than One Individual or Group Destinations
It is possible to edit the information for multiple registered destinations at the same time. This is convenient when, for

example, you want to change the company name for different registered departments of the same company.

1. With the Address Book for Network FAX dialogue box open, select the multiple destinations that you want to edit.

2. Click on the       Edit button. The Multiple Address Edit dialogue

box will be displayed.

3. Put a check mark in the checkbox of the common item that you want

to edit (“Registration Name”, “FAX Number”, “Subaddress”,

“Password”, “Company Name”, “Department Name”, “Recipient

Name” for an individual destination, and “Registration Name” for

Group Destinations), and then enter the new information.

4. Click on the OK button. The display will return to the Address Book for Network FAX dialogue box and the edited

information will be displayed.

5. In order to actually register the edited information in the Address Book, select Apply from the File menu (or click on the

 Apply button).
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4-4  Editing Individual and Group Destination Information

(3) Search/Replace the Contents of a Particular Entry Item
It is possible to search for and replace data for any entry item for multiple registered individual or group destinations. For example,

if a change is made to a city's area code, you can select multiple destinations and change the area code for their fax number with

the new one all in one batch.

2. Point at Replace under the Edit menu, or click on the

           Replace button. The Replace text dialogue box will be

displayed.

3. Put a check mark in the checkbox of the common item that you want to edit ("Registration Name", "FAX Number",

"Subaddress", "Password", "Company Name", "Department Name", and "Recipient Name" for an individual destination

and "Registration Name" for Group Destinations).

4. Enter the information that you want to change in the Find text
field (left column) for the corresponding item.

Enter the new information in the edit box of the Replace text
field (right column).
Note: For fax numbers, the leftmost sequence that matches

the entered information will be replaced. (Example) With fax
number “555-33-1555”, if you enter “555” in the Find text field
and “111” in the Replace text field, the fax number will be

changed to “111-33-1555”. For other items, all matching
sequences will be replaced.

5. Click on the OK button. The display will return to the Address
Book for Network FAX dialogue box and the edited
information will be displayed.

6. In order to actually register the edited information in the Address
Book, select Apply from the File menu (or click on the 

Apply button).

1. With the Address Book for Network

FAX dialogue box open, select the

multiple individual or group

destinations that you want to edit.
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4-5  Deleting Individual and Group Destination Information

1. With the Address Book for Network FAX dialogue box open, select the individual or group destination entry that you

want to delete.

An icon will appear above the list to indicate whether it is an individual ( ) or group destination (  ).

2. Click on the  Delete button.

The selected entry will be deleted from the list.

3. In order to actually delete the selected entry from the Address Book, select Apply from the File menu (or click on the 

Apply button).

4-6  Importing Address Data

(1) Importing FDT Files

You can import and use FDT formatted address lists (file name: xxxx.fdt) previously made with this Address Book software.

1. With the Address Book for Network FAX dialogue box open, select Import under the File menu and then select

Address Book from the successive submenu. The Open dialogue box will appear.

2. Access the folder that contains the desired FDT file.
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3. Select the desired FDT file and then click on the Open button.

(2) Importing CSV Files

2. Access the folder that contains the desired CSV file.

3. Select the desired CSV file and then click on the Open button. The Import dialogue box will appear.

4. Use the dropdown menus to select the fields in the CSV file that correspond to the various fields (Registration Name, Fax

Number, etc.) in this Address Book.

You can import and use CSV-formatted address lists created with other software.

1. With the Address Book for Network FAX dialogue box open, select Import under the File menu and then select CSV

file from the successive submenu. The Open dialogue box will appear.

4-6  Importing Address Data
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5. Click on the OK button in order to access the Confirm imported contents dialogue box.

6. Check the imported addresses and select those entries that you want to add to this Address Book. The number of entries

that you select will be displayed in the Number of selected addresses field. Click on the Add To Address Book button

and the total number of entries that will be added to this Address Book will be displayed in the Number of added

addresses field. (The addresses you add will be deleted from the list.)

NOTE

If either of the following symbols appears in the list, that address can NOT be added to this Address Book as is.

?: That name is already registered in this Address Book, or the number of characters in the name exceed the acceptable

limit.

!: This information may include data which can not be handled by this Address Book.

In either of the above cases, click on the Edit button and refer to the character limits for each field under “4-1  Registering

Destination Information” on page 4-3 and correct the data as appropriate.

7. Once you are finished with the importing procedure, click on the OK button.

4-6  Importing Address Data
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4-7  Exporting Address Data
You can save the data created using this Address Book software as a FDT file.

1. With the Address Book for Network FAX dialogue box open, select Save as under the File menu. The Save as

dialogue box will appear.

2. Select the location in which you want to save the data.

3. Enter the desired file name and then click on the Save button.
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Section 5  Specifications

� Operating Environment

Hardware............................................. IBM PC-AT compatible computer

Interface .............................................. 10BASE-T or 100BASE-TX

Operating system ................................ Windows NT 4.0 (Server, Workstation) + SP5 or later,

Windows 2000 (Professional, Server, Advanced Server),

Windows 98 (Second Edition), Windows 95 (OSR2 or later),

Windows Me and Windows XP

� Network FAX Transmission

Transmission Resolution ..................... Normal (200 dpi x 100 dpi equivalent)

Fine (200 dpi x 200 dpi equivalent)

Ultra fine (400 dpi x 400 dpi equivalent)

Document Size .................................... Standard paper sizes only (Maximum 11" x 17" [A3])

Automatic Redialing ............................ Controlled at the fax machine

Delayed TX ......................................... Based on settings in the Network FAX Driver (setting is possible to any 1 minute

increment within the subsequent 24 hour period)

Concurrent print .................................. Fax transmission and concurrent print-out at the fax machine is available

Transmitted Faxes .............................. Fax data files delivered to designated computer (where Scanner File Utility is installed)

in designated format (PDF or Multi-page TIFF)

Broadcast Transmission ...................... Up to 80 destinations

Rotation Transmission ........................ Available

Restricted Access ............................... Based on entry of access code in the Network FAX Driver. Viable access code

registration and Restricted Access management performed at the copy machine*.

(* Performed at the fax machine in the case of models other than the KM-3035/

4035/5035/C850.)

Cover Page ......................................... Format settings available in the Network FAX Driver

Maximum No. of Fax Pages ................ Up to 256 pages (when sent using Windows 95/98/Me)

Up to 1000 pages (when sent using Windows NT/2000/XP)

* The maximum amounts noted above may not be attainable depending upon certain

fax conditions.

� Network FAX Reception

Received Faxes .................................. Fax data files delivered to designated computer (where Scanner File Utility is installed)

in designated format (PDF or Multi-page TIFF)

Reception Notice ................................. Notice of fax reception by e-mail (to a maximum of 10 e-mail addresses) or directly

to computers on the network (to a maximum of 10 computer addresses)

Long Fax Pages .................................. Long pages are not separated for delivery. Pages which exceed 17" [431 mm] can

only be saved as TIFF files.

� Miscellaneous

Address Book ...................................... Individual and group destination registration available (up to 3000 destinations)

Imported file format: CSV or FDT (proprietary format)

Exported file format: FDT (proprietary format)

Network FAX Transmission Report ..... Can be delivered as an e-mail attachment to a designated address (includes

transmission under Restricted Access)
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